Guidelines for Managing and Naming Files

While file naming may seem like an insignificant detail, developing a descriptive file naming
system can help minimize file access and management issues. What's more, developing
such a file naming system--especially when a consistent system is not in place--can have
added benefits, such as improving access through better search ability and browse ability,
and improving access for everyone who may, now or later, need to access project files. A
filename may contain any alphanumeric character, including the letters A to Z and numbers
from O to 9. No two documents in the same folder can have the same name. This also
applies to folder names. Each folder must have a different name.

Use alphanumeric characters (letters from A to Z and numbers from O to 9) Use
descriptive names Use underscores rather than spaces Avoid numbering if merges
might be a part of the process Use short names (less than 30) Be consistent

Use descriptive names At some point in a file's lifetime, someone other than you will have
to find it. This may not sound like a problem for a small project, but as a project grows and
as the number of files required for that project increases, finding a specific file becomes more
difficult. You can avoid this problem by including a hint to a file's contents within the name of
the file.

Use alphanumeric characters As you're developing a file naming system, avoid
using special characters, including these:
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Instead, use alphanumeric characters (letters and numbers). Although some special
characters are relatively safe, keep in mind that some operating systems or programs may
not recognize special characters or may "reserve" them for special purposes. Even if one
operating system or program allows certain characters, others may not. Bottom line: Avoid
using special characters in file names whenever possible.

Use underscores rather than spaces As mentioned, using spaces in file names can
potentially cause problems for some users; however, using spaces between words in the file
name can help readability. You can accommodate both guidelines by using an underscore ()
between file name components, rather than spaces such as this example:
Example_Username.doc. This character is safe, and it provides the visual break between
words and characters that can help readability. Avoid numbering You may be tempted to
use numbering when naming documents and screen captures, but this can pose some
significant problems if you have to merge file contents or add new files between existing
ones. Suppose you're working on a manual with six chapters. You create six different files,
named Chapterl, Chapter2, and Chapter3 and so on. Now suppose that near the end of
production, the Boss decides to merge Chapter 1 with Chapter 2, switch Chapter 3 with
Chapter 5, and split Chapter 4 into two separate chapters. Using the numbered file nhaming
method, you would have to rename all of the files; you may also have to update external
files that reference those chapters.



Use short names Back in the DOS and early Windows days, all file names had to be in a
standard 8.3 format (eight characters for the name, a period, and three characters for the
file extension). These days, a Windows file name can contain up to 255 characters, including
spaces. While it may be tempting to use all 255 characters for a file name, you shouldn't, for
a couple of reasons. First, some programs cut off long file names in dialog boxes, making the
file names difficult to read or forcing you to resize the dialog box, if possible. Unless you
know that long file names always work in your environment, consider devising a series of
two-character or three-character codes and creating your file names based on those codes;
for example, rename "UserlD_Login_Screen.doc" to "UidLogSn.doc." Moving files between
Windows and Mac computers will not allow a file name, including the extension to be over 30
characters. So keep a file name less than 30 characters to be safe. Windows treats any
characters following the last period in the filename as an extension. Windows filenames are
not case sensitive. MyFile.doc is treated the same as MYFILE.DOC and myfile.doc. Word
marks temporary files with a beginning tilde (—~) character

Be consistent You can more easily browse for documents in a directory if you save the files
with names consistently.

IntroDickinsonV1
IntroDickinsonV2
IntroDickinsonV3

This could be very handy if documents are typically accessed by document type or
within the word program. If documents are typically accessed by the program, then
providing that information first might be more effective, as in:

V1lnstallGuide
V2IntroManual
V3UsersManual

Such a convention might not be needed if you are using short file names or if you
typically don't have many files within a directory; however, being consistent in naming
files can aid users in locating files quickly.

While spending time searching for files and finding good file names won't put your projects
in peril, such problems can be frustrating and time consuming. Although these file naming
guidelines may not meet every file naming need or situation, they can help minimize
problems that crop up, help you (and others) access files more quickly, and help overcome
challenges in managing files over time.

More Advanced Features

Some common buttons in the Save As dialog boxes are the Back Arrow and the Up
One Level icons which appear to the right of the Save In field. These allow you to
take a step back, or move up one level at a time if you have chosen the wrong
subfolder.

Advanced features in some programs allow you Save As Type, which is to say change
the type of file from its default type. Microsoft Word, for instance, allows you to save
files in various WordPerfect formats. Excel can save files as CSV (Macintosh)

formats. There are many other choices.



Why Use Save As

You may also File, Save As if you simply want to save the file you are working with
under a different name, or in a different location. Perhaps the changes you made need to
be approved before becoming permanent. Save the file under a different instead of its
usual name. Or perhaps you are sending out letters to several people, and although most
of the information is the same, each one has certain changes that need to be made
separately. Use Save As to save each version out under a different name.

Remember, using Save As and the drop down list at the top of the Save As dialog box, you
can decide where you want to save the file. I will make you look at the place it will be saved.
When you wish to find the file again, select Open from the File menu. This time the field at
the top of the dialog box is labeled Look In, but it allows you to navigate through the various
locations and subfolders on your computer, just as when you were finding a place to save
your file. Return to the folder or location where the file was saved, left-click on the file name
to select it, and click on the Open button in the lower right-hand corner of the dialog box to
open the file.

Viewing Files and Folders Overview

Windows provides several new ways for you to arrange and identify your files when you view
them in Windows XP special folders, such as the My Documents, My Music, My Pictures, or My
Videos folders. When a folder is open, you can use any of the viewing options (located on the
View menu) that are described in this section.

NOTE: The arrangement options in each folder vary with the type of folder that you open.
For example, the Filmstrip view is only available in folders containing pictures.

e Show in Groups

When you use the Show in Groups option, you can group your files by any detail of the file,
such as name, size, type, or date modified. For example, if you group by file type, image files
are displayed in one group, Microsoft Word files are displayed in another group, and Excel
files in another. Show in Groups is available in the Thumbnails, Tiles, Icons, and Details
views. To show your files in groups, on the View menu, point to Arrange Icons by, and then
click Show in Groups.

e Thumbnails

Thumbnails view displays the images a folder contains on a folder icon so that you can
quickly identify the contents of the folder. For example, if you store pictures in several
different folders, in Thumbnails view, you can tell at a glance which folder contains the
pictures you want. Windows displays up to four images on a folder background by default.
You can also choose one picture to identify a folder in Thumbnails view. The complete folder
name is displayed under the thumbnail.

- Tiles

Tiles view displays your files and folders as icons. The icons are larger than those in Icon
view, and the type of information that you select is displayed under the file or folder name.
For example, if you sort your files by type, Microsoft Word document is displayed under the
file name for a Microsoft Word document.



e Filmstrip

Filmstrip view is available in picture folders. Your pictures are displayed in a single row of
thumbnail images. You can scroll through your pictures using the left and right arrow
buttons. If you click a picture, it is displayed as a larger image above the other pictures. To
edit, print, or save the image to another folder, double-click the picture.

* Icons

Icons view displays your files and folders as icons. The file name is displayed under the icon;
however, sort information is not displayed. In this view you can display your files and folders
in groups.

e List

List view displays the contents of a folder as a list of file or folder names preceded by small
icons. This view is useful if your folder contains many files and you want to scan the list for a
file name. You can sort your files and folders in this view; however, you cannot display your
files in groups.

e Details

In Details view, Windows lists the contents of the open folder and provides detailed
information about your files, including name, type, size, and date modified. In Details view
you can also show your files in groups. To choose the details that you want to display, click
Choose Details on the View menu.

Group Files by Using Folder Views

To group files using folder views, follow these steps:

1. Double-click the folder that you want to configure folder views for, for example, My
Documents, My Music, or My Pictures.

2. On the View menu, point to Arrange Icons by, and then click the command that you want
to use, for example, Type.

3. On the View menu, point to Arrange Icons by, and then click Show in Groups.

The files in the folder are grouped by the view that you selected in step two. For
example:

< When you arrange icons by Name, the files are grouped alphabetically. The header over
each group contains the first letter of the file names contained in that group.

< When you arrange icons by Size, the files are displayed in groups of files that are about the
same size. The header over each group contains the general size of the files in that group,
for example, Tiny, Small, and Medium.

< When you arrange icons by Type, the files are grouped by type. Headers are displayed over
each group that describes the type of file in that group.

< When you arrange icons by Artist, music files are grouped under artist headings. Files that
do not have an artist are grouped under the heading of Unspecified.

= When you arrange icons by Album Title, music files are grouped under headings that
specify the title of the album containing each file. Files that do not have an album title are
grouped under the heading of Unspecified.

< When you arrange icons by Year, music files are grouped by year. Files that do not have
year information are grouped under the heading of Unspecified.

= When you arrange icons by Track Number, music files are arranged by the music track on
which they are displayed. Files that do not have a track number are grouped under the
heading of Unspecified.



< When you arrange icons by Duration, media files are grouped by their length of play. Files
that do not have any duration are grouped under the heading of Unspecified.

< When you arrange icons by Modified, picture files are grouped according to their most
recent modifications. The header over each group describes the general time that the last
modification was made, for example, Today, Last month, or Two months ago.

< When you arrange icons by Picture Taken On, picture files are grouped according to their
date stamp. Picture files that do not have a date are grouped under the heading of
Unspecified.

< When you arrange icons by Dimensions, picture files are grouped according to their
resolution. The header over each group describes the resolution of the pictures in that group,
for example, 320 x 240, 600 x 800, or 800 x 600.

More Tips for Managing Your Files

1. Use My Documents. For many reasons, it's smart to take advantage of My Documents
feature in Microsoft Windows. To open My Documents in Windows, click Start, and then click
My Documents. My Documents provides an easy way for you to store your personal
documents. By using My Documents, you will be better able to:

- Find files. Windows provides easy access to the My Documents folder (and its
subfolders) in many places: through the Start menu, the task pane in Windows Explorer,
common File Open and File Save dialog boxes, and other places.

Note: Windows Explorer displays the structure of files and folders on your computer. To
open Windows Explorer, click Start, point to All Programs, point to Accessories, and then click
Windows Explorer.

- Back up files. Keeping all your files in one place is an essential first step in developing
a practical backup strategy. Dickinson College recommends saving files to the network
because they are backed up.

- Keep files separate from programs. By separating document files and program files
you reduce the risk of accidentally deleting your documents when you install or upgrade
programs.

2. Adopt consistent methods for file and folder naming. Develop a naming scheme for
the kinds of files you create most often and then stick to it.

3. Keep names short. Even though Windows allows you to use long file names, it does
not necessarily mean you should. Long names produce cluttered displays. Brevity promotes
clarity.

Let your folders do some of the naming.

4. Separate ongoing and completed work. To keep the My Documents folder from
becoming too unwieldy, use it only for files you're working on. This reduces the number of
files you need to search through and the amount of data you need to back up. Every month
or so, move the files you're no longer working on to a different folder or location—preferably
not in My Documents.

5. Store like with like. Restricting folders to a single document type allows you to take
advantage of folder templates in Windows Explorer. This makes it easier for you to find files.
For example, with all your graphics in a single folder, it's easy to use the Filmstrip view and
slide show feature in Windows Explorer to find the right picture for your newsletter.

6. Avoid big folder structures. If you need to put so many subfolders in a folder that you
can't see all of them at a glance, consider creating an alphabetic menu.



7. Use shortcuts and shortcut links instead of multiple copies. If you need to get to the
same file from multiple locations, don't create copies of the file. Create shortcuts to it
instead. To create a shortcut, right-click on the file and click Create Shortcut. You can drop-
and-drag the shortcut to other locations.

8. Use abbreviations. Keep file names short by using common abbreviations, such as
"MTG" for meeting or "ACTG" for accounting. This makes the file names more descriptive and
you can more easily find files through Search if it's necessary.

9. Use thumbnails. Search through folders in the Thumbnail view. They're easier to see
and you can put a picture or clip art on the folder so that it's more easily recognizable. For
example, a folder that contains information about a product can have a picture of the
product—or something else that reminds you of the folder contents.

To view your folder list in Thumbnail view, on the My Documents folder, in the toolbar click
View and then select Thumbnail.

10. Use common names. To make it easier to search for documents, name your files and
folders with easily found names, such as model numbers, project names, or the project lead
in the title.

11. Don't save unnecessary files. Be selective about the files you keep. You probably don't
need to keep them all. With e-mail, for example, you rarely need to keep everything you
receive.

12. Use My Recent Documents. To find a file a just worked on, use My Recent Documents
in the Start menu.

13. Organize files by dates. Use a date in the document name. Such as jeb100201, which
would mean October 2, 2001. This puts all the job materials together and sorted by date.
14. Change to folder style. Right mouse, choose Properties, then the Customize tab you
will find folder options.

Mac Specific Instructions

In Windows computers, the hard disk is usually labeled C: In Macs, it is titled Macintosh HD.
To get to the hard disk, Mac users will double-click on the Macintosh HD icon. Once you have
opened the hard disk folder, you will see that it already has other folders inside of it. To
create a new folder, click on the word File in the menu at the top of the screen. Then choose
New Folder. A new folder will appear with the name "untitled folder" highlighted. Just type in
the name that you would like to give the folder and the words "untitled folder" will disappear.
The title that you typed will appear under the folder. If for some reason the folder still reads
"New Folder," simply click on the folder, wait a second, and click again. You will then be able
to retype the name.

Don't get yourself in the situation where you are spending a great deal of time looking for
files you created earlier. Keeping your computer files and folders in order can play a big
part in making your computing life easier. Get yourself a plan and follow it. The time that
you spend organizing your files will be well spent. Don't forget, organization is the key.



